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Master Software Series 

mySewnet™ Embroidery Software  
Platinum Level  

Windows and Mac Version 

 

Embroidery For Quilters  
with mySewnet™ Embroidery  
Author:  Janie Lantz 

 

Quilting is all the rage across the world, and many quilters are adding embroidery to 
their quilt blocks, then finishing their quilts in the embroidery hoop!  Let’s explore 
techniques for designs to create some unique blocks for a quilt, and then craft 
designs to quilt the blocks on our embroidery machines!  We’ll utilize multiple 
elements of the mySewnet™ Embroidery Platinum package, including Digitizing, to 
design embroidery suitable for customizing blocks and then finishing with quilting in 
the hoop! 

➢ Additional instructions specific to Mac are shown in green. 

 

Navigating the Modules/Apps 
Finding your modules/applications is easier when you know where they are stored!  
Get the basics under your belt, and then Reset All in Configure, so you are navigating 
from default menu settings as you begin your lesson! 

1. In Windows, open the Desktop mySewnet™ program folder. 

• Inside the program folder, you’ll find the shortcut to open the mySewnet 

Embroidery Module and a Tools folder. 

• If you’d like a shortcut to the Embroidery module on your Taskbar, 

right click over the Embroidery module icon, and select Pin to 

Taskbar. 

• Open the Tools folder in Windows File Explorer to view the other 

shortcut icons. 
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Create additional icons to the Start menu or Windows Taskbar as desired! 

➢ In Mac, open Launchpad  , and browse 
through the menus to see the Embroidery icon 

. 

➢ To create a shortcut in the Dock, click and drag 
the Embroidery icon down into the Dock. 

2. Open mySewnet™ Configure . 

Resetting All Modules/Apps brings all menu links and 
toolbars back to their original settings, useful for working through a set of lessons to 
standardize your menus and view. 

3. Select the Utilities tab. 

4. Click Reset All Modules/Apps. 

• In Windows, click OK to the three prompts to check and ensure all modules are 

closing, and the mySewnet software has reset all the modules. 

• Click OK to the system prompts, then OK to close the Windows mySewnet™ 

Configure. 

➢ In Mac, click Reset all Apps if no apps appear to be running. 

➢ Close  mySewnet™ Configure. 

A link to mySewnet Configure is also found in the Welcome screen sidebar in 

Windows, or in the drop down from mySewnet™ Embroidery  
in the main menu bar in Mac. 

 

Part 1:  Embroidered Blocks with SuperDesign Elements 

(Gold and Platinum) 
SuperDesigns have many themed elements that would make delightful quilt blocks.  
Many SuperDesigns have properties settings, and all SuperDesigns are working 
elements with green corner handles, so they can be adjusted for size and proportion 
without degrading their stitch quality.  
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 SuperDesigns in Embroidery Module/App 

SuperDesigns fall into multiple Categories, including many with Pattern Fill and Line 
stitches, some special Effects, a few dimensional (Tassels), and Applique.  Let’s use 
some SuperDesigns with a theme suitable for a table runner. 

1. Open mySewnet™ Embroidery . 

In Windows, if you didn’t add a shortcut to the Taskbar, browse back to the main 
mySewnet™ desktop folder in the Windows File Explorer Window. 

➢ In Mac, open Launchpad   again, and select the Embroidery icon, or open 
from a shortcut on the Dock. 

The Embroidery module/application opens to the File Menu welcome screen, so you 
can select a recently used file, start a new Blank Canvas, or open a link to another 
Wizard/Assistant or to another module/application. 

  
2. In New Project, select Blank Canvas. 

➢ In Mac, select Blank Project, click Next.  

  
3. Hoop Selection:  

• Hoop Group Universal,  

• Hoop Size 260mm x 260mm – Universal Square Hoop 5.   

• Orientation Natural. 
➢ Mac:  Brand Universal, Machine Group Universal, 260mm x 260mm – Universal 

Square Hoop 5.  Orientation Natural. 
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TIP:  When working with a specific brand of embroidery machine, select the 
brand/group, and then the machine-specific hoop, so you can export for your hoop 
when you’re ready to stitch!   

When you are designing for a specific block size, use Enter Hoop Size, then specify the 
Height and Width of your block.  If you design for a block that’s too large for any 
existing hoop for your embroidery machine, you may need to custom-split the 
embroidery and save in multiple sections. 

4. Click OK. 

5. Select the SuperDesign tab. 

➢ In Mac, click  in the Control Panel tabs. 

6. Select Food and Drink in the SuperDesign Category. 

7. Open the Gallery view in Windows  and look through the Coffee Time 1 
designs. 

 
➢ In Mac, scroll the viewer up or down to see all the SuperDesign sets in the Food 

and Drink Category.  
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8. Select Design 1 – Coffee Break. 

9. Open Select Style, and choose Color.   

• The alternate style (Select Style  in Windows, Style 
in Mac) for this design is Line, which utilizes line type 
Triple Stitches. 

10. In Stitch Type, select Satin Column, to adjust the satin 
stitches that form the words. 

The Satin Column pattern is initially 0, so the stitches have no patterning.  They 
simply stitch back and forth as a ‘zigzag’.  Zigzag stitches might tend to snag on a 
quilt, so let’s break the stitches up with a Pattern Fill. 

11. Open the Pattern Gallery (  in Windows,   in Mac) and browse to Category 
Gradients and Lace, then select Pattern 256 (cursor over the preview to see the 
number). 

➢ To close the Gallery in Mac, click the pattern preview square again in the 
Settings box. 

We are going to change the letters to have a gradient fill, and Gradients and Lace fill 
patterns are optimized to reduce travel stitches or force them to the outer edges for 
a cleaner area of stitches. 

12. In Underlay, uncheck Edge Walk, and check Zigzag. 

Zigzag underlay will be smoother under a Satin Column, and Running stitches used 
for Edge Walk can sometimes peek out at the edges under very curving designs. 

13. Compensation should be 0. 

Use Compensation when you need to increase an area’s relative size to compensate 
for ‘shrinkage’ across the area of stitches during the push and pull of stitching.  
Compensation is useful when gapping occurs between areas of stitches because the 
fabric shrinks in during stitching. 

14. Density (Constant in Mac) is 5 initially. 

Since we haven’t done a test stitch, leave Density at the initial setting, then after you 
do a test stitch, adjust by raising the number to decrease the Density, or lowering the 
number to increase the Density.  Think of the Density number as the spacing between 
stitches, the lower the number, the closer or more Dense the stitches! 

15. Gradient is off by default. 

Wouldn’t it be fun to make the letters in graded shading so our lettering is 
reminiscent of coffee with cream? 
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16. Select the Gradient option. 

➢ In Mac, click the three dots button  to open Gradients settings. 

17. Select Multicolor Gradient. 

18. Click Add Marker 3 times, so you see a total of 5 
markers on the lower edge of the  gradient 
preview bar. 

Each lower marker on the gradient preview bar 
represents a thread color change in the final embroidery.  We can select and change 
each thread color, and then move the lower markers to adjust where each color 
stops and the next color starts across the gradient. 

19. Click the farthest left marker (as you face the display) so it shows a blue highlight. 

20. Click the Change Thread Color icon  to open the Color Selection box for the 
threads database. 

TIP:  You can also double click the selected marker to open the Color Selection box! 

21. Select Show All Thread Ranges. 

22. Select Robison-Anton Rayon 40 as the thread manufacturer. 

23. Select thread color 2232 Ecru as the first thread color. 

TIP:  Click in Find Thread and type in the thread number after you have selected the 
manufacturer’s thread, and your target thread is automatically selected. 

In Mac, click the thread color in the preview box to select it. 

In Mac, if you typed into the filter, click the X to close out the filer and see the 
complete range of thread colors again. 

24. Click OK to change the first thread color marker in the Gradient. 

25. Click the second marker from the left. 

26. Click the Change Thread Color icon . 

27. Change to Robison-Anton Rayon 40, color 2630 Pro Beige, then click OK. 

28. Change the middle marker to Robison Anton Rayon 40, color 2474 Rattan. 

29. Change the second from the right end to Robison Anton Rayon 40, color 2477 Sand 
Dune. 

30. Change the far right marker to Robison Anton Rayon 40, color 2337 Expresso. 
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31. Click and drag the lower arrows with color indicators along the gradient preview to 
adjust the location of each thread color. 

 
You can rearrange the order of the color markers anywhere, in any sequence, along 
the bottom of the gradient line viewer as well, changing the stitch order of the 
threads.    

 

The gradient preview shows small arrows across the top.   

32. Click and drag the top arrows to change how the color gradient is blended between 
two color markers.   

As you drag the marker, the preview will show how colors blend in each adjustment. 

Each top marker can only be moved between its two color markers 

33. Click OK to finish adjusting the Satin Column preferences. 

➢ Click OK to close the Gradient settings, then OK again to close the Satin Column 
settings box, in Mac. 

You can either adjust the Stitch Settings before adding the SuperDesign, or right click 
and select each stitch from a pop up list to adjust preferences after you Apply a 
SuperDesign, when the SuperDesign is selected. 

34. Click Apply (bottom of the Control Panel in Mac) to create the SuperDesign at 
the default size. 

The select box shows green corner handles, indicating the 
design is fully adjustable.  If you adjust height, width, 
proportions, or any of the settings from the pop up right-click 
menus, the design stays true to the settings you’ve selected. 

35. To make the lettering larger but keep it proportional and keep 
the design centered over the original location, hold down the 
keyboard CTRL and Shift keys in Windows or option and Shift 
keys in Mac, while you drag a corner handle inward or 
outward. 

TIP:  When select box corner handles are green, you can adjust sizing or other 
properties unlimited times. 
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To adjust a design proportionally by dragging from a pinned opposite corner, hold down 
the SHIFT key as you drag the corner. 

To adjust height and width independently but pinned at the original center, hold down 
the Control key in Windows, or option key in Mac. 

To rotate the design, move the Center of Rotation  to pin the location around which 
you want the design to rotate, and then drag the rotation handle  on the right side of the 
select box. 

To adjust a design’s sizing with precision, use Modify Design , found in the Home tab 
in Windows or Modify Design and Edit Design in the Design menu, main menu bar, in Mac. 

36. Don’t forget you have unlimited Undo and Redo, if you make a change and it isn’t 
what you planned! 

• Windows Shortcuts:  Undo is Control Z, Redo is Control U. 
➢ Mac Shortcuts:  Undo is Command Z, Redo is Shift Command Z. 

37. Click Center in Hoop  to center the design after you have adjusted its size (Home 

tab, main toolbar, in Windows, Design tab  in Mac Control Panel, to the right of 
the Color Select box. 

38. Click Life View  to see how the design appears after Export, then zoom with the 
slider.   

• Use Position to move around the zoomed view .   

• Use Rotation  to turn the positioning to show how stitches will look as the 
angle of light changes.   

• Use Reset  to return to the initial default view. 
39. Click Cancel or Close to exit Life View. 

40. Save as a working design file named CoffeeBreakEmbroidery.vp4. 

• In Windows, click Save As  in the Quick Access toolbar at top right. 
➢ In Mac, Save is in the Actions menu.  Alternately, hold down the keyboard 

option key, click File in the main menu bar, and select Save As.  Or change the 
file name from the Title bar. 

Save a working file so you can quickly reopen it if you somehow lose the element 
while making further customizations. 
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Designs that are saved from the Embroidery module/application are working files 
saved in a special type of .vp4 that preserves the unfinalized elements within the 
design.  Working .vp4 files can be reopened and worked with as if they were never 
closed, retaining any open elements, and each separate design element. 

 

Add Quilting with Quilt Block Wizard / Assistant 

Let’s make this into a quilt-as-you-go block, where you hoop 
the fabric, embroider the words, then add batting and backing 
under the hoop to make a pre-quilted block you can later 
assemble into a quilt. 

41. Make sure the Coffee Break design is selected (showing a 
select box with green corner handles, highlighted in the 
Filmstrip at the left of the work area).  

• To select, simply click the design in the work area, or click its Frame in the 
filmstrip. 

42. Cut the design from the work area so it is placed on the Clipboard Block. 

• In Windows, the Cut icon  is in the Home tab, or the Cut command is 
available from the right click menu from the work area or Filmstrip.  You can 
also use the Ctrl X keyboard shortcut to cut any selected design or selected 
group of designs. 

➢ In Mac, Cut is in the Actions menu , or in the right click menu from work 
area or Filmstrip.  Shortcut is command X. 

43. Select the Create tab (  in Mac Control Panel) to view icons for linking to other 
wizards/assistants, and other modules/applications, within the mySewnet™ 
ecosystem. 

44. Click the Quilt Block Wizard / Assistant . 

45. Click each of the options to review their block type. 

46. Select Filled Quilt Block; Inner Embroidery so you can design quilting to fit within 
your block shape, and around the embroidery you just cut to the Clipboard Block. 

47. Click Next or Continue. 
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48. Open the Shape menu.  

• You can select from 9 different basic quilt block shapes. 

• Each shape has options for the size, the angle of Rotation, and whether 
to include a cut-line for a seam allowance for quilt-as-you-go blocks. 

49. Select Shape 1, a Square. 

• When you select Side for Enter Size, you can specify a length for a block 
side, and the other side is automatically set as proportional, because 
square blocks have the same height and width dimensions. 

50. Select Shape 2, a Rectangle. 

• You can specify a length for the height, and one for the width, because 
rectangular blocks have different dimensions for height and width. 

51. Work through each of the other blocks to see how their size is set. 

52. Select Shape 1, the Square, for this project. 

53. In Enter Size, select Side. 

54. In Measurement A, enter 258mm (or the size of your targeted block less 2mm wiggle 
room). 

➢ Tab to refresh the field in Mac.  Some fields will refresh automatically, but most 
don’t, so get into the habit of tabbing after you type into a field or make a 
selection. 

Measurement B will calculate automatically to the same length, though the field is 
grayed out and will show a default number setting. 

55. Uncheck Include a Cut Line. 

TIP:  Cut the squares for your blocks larger so there is extra fabric for hooping and 
seam allowance when using a Quilt-As-You-Go technique.  If you include a ‘marker’ 
for the cut line to add seam allowance within the working area of the hoop, you’ll 
lose some of the space in your hoop to the seam allowance. 

To maximize the usable space for your block in the target hoop, 
uncheck the Cut Line feature. 

56. Click Next or Continue. 

57. In Load Embroidery, the design you cut to the Clipboard Block is 

visible in the Clipboard viewer, and you can simply Paste  or Paste 
Embroidery to place it for the quilt block.  

58. Click Next or Continue. 
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59. Use the Adjust Embroidery step to fine tune placement within the quilting design 
you are building. 

• Cursor over the embroidery in the preview window to click and drag it’s position 
around the block area. 

• You can change the embroidery’s Angle of rotation . 
Angle remembers 0 as the original angle, so you can simply type 0 into the Angle 
field to return to the original orientation! 

• Use Mirror Horizontally  to flip the embroidery side-to-side along the 
vertical axis. 

• Use Mirror Vertically  to flip the embroidery top to bottom along the 
horizontal axis. 

Note:  In the Windows OS, Mirror will Fix (Finalize or Close) design elements that 
have green corner handles, so the corners change to white, indicating they are fixed. 

• Adjust the Margin between the quilting stitches and the outer edge of the 
embroidery by mm.  Margin of 0 leaves no space, and Margin setting will max 
out depending on size of hoop and space available around the embroidery 
within the block size parameter. 

 
For complex embroideries, some areas inside the embroidery may not fill with 
quilting stitches even at a setting of 0. 
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60. Try out some Margin settings, and select your favorite.   

• Alternately, choose a setting of 4mm, as shown. 
61. Click Next or Continue. 

Select Fill Pattern offers multiple ways of designing the quilting stitches around your 
embroidery, with Stipple being the default first option. 

62. Click Options beside Stipple , and try out some different settings. 

• Click OK after each setting change to see the preview. 

• Click Options again to make further changes. 
63. Click another Fill Pattern style, and click Options to try out different settings. 

Tip:  Adjust Density, Spacing or Gap to a higher number to ‘open up’ the lines of 
stitching. 

Below, Diamond/Square/Crosshatch, Curved Crosshatch Fill, Options/Spacing 10mm. 

 

64. Select Motif Fill , then click Options. 

Here, you can select from a single motif, or two motifs (same or different) to vary the 
look.  You can also adjust spacing between the lines of stitches, and make them 
offset from Motif 1 to Motif 2 in alternating lines.  In Options, set stitch size and type. 
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65. Change the Motif Fill Options as shown in the tables below (or choose your own 
through selecting and adjusting different stitches): 

When embroidering to embellish a block, smaller and closer Motif Stitches are 
acceptable. When using an embroidery to quilt in the hoop, quilting may be more 
attractive and have a softer hand if Motif Fill areas are more open. 

For Windows OS: 

In the Motif 1 tab, select: Group: Universal 

Category: Images 1 

Pattern 5 

Adjust Size to Height 50mm, Width 80mm 
(Proportional lock on) 

In Motif 2 tab, check Use Motif 2 Group:  Husqvarna Viking 

Category:  K Omnimotion Stitches 

Stitch 19 

Size:  Height 30.5mm, Width 45mm 

Spacing tab: Vertical Gap 5% 

Options tab: Running Stitch, Length 2.5mm 

For Mac OS: 

Check the box to select 2 Motifs  

Click Motif 1  Group: Universal 

Category: Images 1 

Pattern 5 

Adjust Size to Height 50mm, width 80mm 

(Proportional lock on ), and tab key 

Click OK. 

Click Motif 2  Group:  Husqvarna Viking 

Category:  K Omnimotion Stitches 

Stitch 19 

Size:  Height 30.5mm, Width 45mm 

Click OK. 

Gap: Vertical:  10 

Offset: 0 

Stitch:  Running Length 2.5mm 

66. Click OK to accept the Options and preview the new stitch motif pattern. 
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67. Click Finish or Done. 

68. Change the last thread color in the Color Select box, Design Panel (Design Panel tab 

 in Mac) to coordinate with your thread color choices, or to blend with your 
background fabric. 

 
69. Use Save As to save the design with a new file name, CoffeeBreakQuilted.vp4. 

• In Windows, Save As in the Quick Access toolbar. 
➢ In Mac, hold down the keyboard Option key, then select File, Save As. 

70. Export into the correct format for your embroidery machine, or use Direct Send to 
mySewnet™. 

71. If desired, Print a template to help with placement: 

• Click File. 

• Click Print (also in Actions in Mac). 

• Adjust the print settings as you prefer. 

• Scroll through the pages to preview each page as it prints. 

• Click Print. 
Tip:  If you like printed templates, you might try printing on a semi-transparent 
vellum type printer paper. 
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Optional Split into 2 Hoopings 

The Quilt Block Wizard / Assistant produces the embroidery and the quilting stitches 
as discrete designs, but they are grouped (orange corner handles on select box). 

If you prefer to embroider the blocks first, then rehoop with the quilt sandwich 
beneath the hoop to stitch the final quilting as a separate step, it’s easy to separate 
the two pieces of the design. 

If your embroidery machine has a positioning system, it’s perfect for 
this technique! 

TIP:  This technique will avoid splitting the quilting and embroidery 
across their stitches, as can happen with Split Project. 

72. Click Reveal Groups  at the bottom of the Filmstrip so you can 
select and edit the two individual designs.  

• The Group is the first frame, and shows the Group symbol  
beside the thumbnail.   

• The numbers at left show the Group’s position in the stitch-out 
order (1) and the number of designs in the group (2). 

73. Make sure the text Coffee Break is the selected design (highlighted in the Filmstrip, 
and selected in the work area). 

74. Use the shortcut keys (Control X in Windows, Command X in Mac) to Cut the design 
and put it on the Clipboard. 

75. Use File, and New Window in Windows (File, New in Mac) to open a new program 
window.   

76. Select Blank Canvas (Blank Project in Mac, then Next), and change to a 260 mm x 
260 mm, Natural Orientation Hoop. 

• Click OK to accept the hoop settings. 
The new window should automatically use the default Hoop settings from the 
previous design’s window. 

77. Right click and select Paste. 

Do not use Paste in Center.  Paste will place the embroidery in the same position in 
the hoop as the original you cut it from. 

78. Select Save As  (File, hold option key, and Save As in Mac). 

79. Name the file as CoffeeBreakQuilted_Part1 and save. 

80. Export so the design in ready to stitch. 
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81. Reselect the first program window with the quilting stitches. 

82. Resave with Save As, naming the file CoffeeBreakQuilted_Part2. 

83. To get stitching quickly with a Wi-Fi connected compatible machine, use mySewnet 

direct-send connectability .   

• For more information on using the Send functions, 
open the mySewnet™ Configure guide 
(https://www.mysewnet.com/en/support/help-
guides/ to use online or download as a PDF), under 
the Plug-in / Sending Embroideries. 

 

 

 

 

 

With two separate designs, you can utilize quilt-as-you-go techniques to stitch the 
design for the block first, then add batting (or batting and backing) to stitch the 
quilting stitches. 

Or, you can stitch all the blocks, piece the top, then sandwich and stitch the custom-
fit quilting designs! 

 

 

https://www.mysewnet.com/en/support/help-guides/
https://www.mysewnet.com/en/support/help-guides/
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Part 2:  Add SuperDesigns via Linking to Digitizing  

(Platinum Package) 
Using linking, we can begin with the Embroidery Module/Application and link to 
Digitizing, to make our own unique embroideries, or to insert Embroidery, 
SuperDesigns, Lettering, and more. When we close the link, we can use Quilt Block 
Wizard/Assistant to quickly add custom quilting.  

What advantage do you gain by using linking to Insert SuperDesign in the Digitizing 
Module/Application?  Additional precision, more options for stitches, fundamental 
ability to adjust size, proportion, or add/remove objects within the design. 

 

1. Open mySewnet™ Embroidery . 

2. Select Blank Canvas (Blank Project and Next in Mac). 

3. Hoop Selection:  

• Hoop Group Universal,  

• Hoop Size 260mm x 260mm – Universal Square Hoop 5.   

• Orientation Natural. 
➢ Mac:  Brand Universal, Machine Group Universal, 260mm x 260mm – Universal 

Square Hoop 5.  Orientation Natural. 

4. Click OK. 

Remember, when working with a specific brand of embroidery machine, select the 
brand/group, and then the machine-specific hoop that closest suits your quilt blocks, 
so you can export for your hoop when you’re ready to stitch!   

Or, use Enter Size to make a custom hoop. 

5. Select the Create tab (  in Mac Control Panel). 

6. Click Digitizing (  in Mac) in the Insert tools. 

• A linking pop-up will appear, and then Digitizing will open. 
Do not close the link, which stays visible when you view the Embroidery 
module/application.  We’ll close the link after we finish designing a new embroidery 
in Digitizing. 

7. In Windows OS, click Cancel to close the ExpressDesign Wizard.  
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8. In Windows Digitizing, Home tab, click Insert SuperDesign . 

➢ In Mac, select the Edit menu, cursor over Insert, and select Insert SuperDesign. 

9. Change SuperDesign Category to Applique. 

10. Open the Design gallery  viewer in Windows, or scroll in Mac. 

11. Select Category Flowers 1, and design 2- Rose. 

12. Click Insert to add the SuperDesign to the work area. 

➢ In Mac, click Apply. 

13. Click Cancel to close the Insert SuperDesigns menu. 

➢ Click  to close the menu in Mac. 

TIP:  Once the Digitizing window has design elements, they are 
also live in the Embroidery window, because they are ‘linked’. 

14. In Digitizing, make sure the whole SuperDesign is selected.   

• If unsure whether all the design’s objects are selected, scroll to the top of the 
Filmstrip, and click the Group frame. 

• Then make sure Box Select  is selected in the Selecting tools (bottom left 
Quick Select toolbar in Windows, Main Toolbar in Mac). 

15. Adjust the size of the applique SuperDesign with Modify Block . 

• In Windows, Home tab, click the bottom half of the Modify Block icon , then 
select Change Design Size. 

➢ In Mac, click the Edit menu, then select Change Design Size. 

16. Select Height first. 

17. Type 6” in the Size field (tab to refresh in Mac). 

18. Click OK to change up the design’s size. 

You can also adjust the selected design by dragging its corner handles, but Change 
Design Size is more precise! 

 

Add a Texturizing Fill over the Appliqué Areas 

Because you can edit to your heart’s desire in the Digitizing module/application, you 
can have it your way, all the way! 

19. Scroll up or down the Filmstrip until you can see the red color change and it’s objects 
(including the two Running Stitch Appliqué sections). 



 

MYSEWNET is a trademark of KSIN Luxembourg II, S.a.r.l.©2023 KSIN Luxembourg II, S.a.r.l. All rights reserved. 

Page 19 of 29 

 

We need to change each applique section individually to retain the Fabric options. 

20. Click the higher Running Stitch Appliqué frame in the Filmstrip.  

The selected frame is highlighted, and is selected in the work area. 

21. Right click over the selected frame in the Filmstrip. 

22. Select Properties (to change just the selected object). 

23. At the top of the properties box change No Fill  to Spiral Fill 

. 

24. In the Fill tab, adjust Density (Constant in Mac) to 20 (tab to refresh in Mac). 

If you wanted more visual texture, you can add a Gradient fill, too! 

25. Select the Line tab and review settings. 

The SuperDesign’s builder used multiples of Satin Column objects to finish up the 
applique to avoid overlapping areas, so the border here is a Running Stitch that gives 
additional securement for the applique pieces. 

26. Select the Appliqué tab. 

• The default for this SuperDesign was Standard Appliqué!  If you 
prefer to use an electronic cutter, choose Precut Piece. 

• If the applique fabric is loosely woven, adjust the Appliqué 
Piece Margin slightly larger so the fabric will cut a little larger 
than the tack-down line.   

• If Match Placement Line is checked, the placement line will be 
the same place (matched) as the cut edge of the slightly larger 
fabric, so you’ll know exactly where to place your custom cut piece!   

• However, the tack-down will still stitch in its original location along the edge of 
the applique object’s original outline, so it will be stepped in from the cut edge 
of the new larger applique piece, providing more securing power! 

27. Select the appliqué settings you want to use for your project. 

TIP:  You can change any setting you want!  Try out a different fabric in the colors 
you plan to use for your quilt! 

28. Click OK to finalize the changes and close the dialogue box. 

The Running Stitch Appliqué has changed to a Spiral Fill Appliqué, reflecting our 
change! 

29. Click the next Running Stitch Appliqué in the Filmstrip. 
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TIP:  Objects stitch in order within your embroidery, beginning with the top of the 
Filmstrip and working down.   

So, the first frame is always the first color stop on your embroidery machine, and the 
object following it the first thing to stitch (so it is considered to be at the back of the 
embroidery as other objects will layer over it). 

30. Right click over the selected frame in the Filmstrip, and select Properties. 

31. Change settings as desired, or to match the first section of appliqué. 

32. Click OK when finished making changes. 

33. Change the Select tool to Edit Points . 

34. Select one of the Spiral Fill Appliqués in the Filmstrip. 

35. Click and drag the Origin command to 
the center of the flower, so the Spirals 
originate at the center of the area. 

36. Select the other Spiral Fill Appliqué and 

move the Origin command  to the 
same place. 

The spirals for both pieces will appear to 
be one continuous spiral! 

37.  Click Life View  and review how the 
design appears upon Export.   

Life View shows how the design will appear 
based on the current default settings for Export. 

To see how the design will look as exported, before viewing in Life View, change up 
the current Export defaults in mySewnet™ Configure. 

TIP:  If working with designs that should not be color-sorted or combined when using 
the Express Send functions, you can open Configure and set your preferred defaults, 
then click OK or Apply in Configure.   

Form a habit to check and make the changes before using Express Send features, like 
Send to Machine or Send to mysewnet™, because Express Send functions use the 
default settings from Configure automatically (unlike Export, which offers the 
Optimize for Sewing choices each time you export.  

38. When finished viewing, click Cancel or Close. 
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39. Work through the rest of the elements in the Filmstrip, looking for other objects you 
would fine-tune or change up. 

Perhaps you’d like to add a Motif Fill over the leaves for more texture.  You can also 
add other stitch objects to enhance, as desired! 

You might want to make new objects in a special stitch order.  Simply 
select the frame in the Filmstrip that is just before the location you 
want the new areas to stitch, and the newly added objects will stitch 
after the selected frame! 

40. In the Filmstrip, select the last object in the green thread color 
change.  

41. In Windows, Home tab, click Insert SuperDesign . 

➢ In Mac, select the Edit menu, cursor over Insert, and select 
Insert SuperDesign. 

42. Change SuperDesign Category to Wreath. 

43. Open the Design viewer in Windows, or scroll in Mac. 

44. Select Category Wreath 2, and design 4 – Swirl 1.  

45. Click Insert to add the SuperDesign to the work area. 

➢ In Mac, click Apply. 

46. Click Cancel to close the Insert SuperDesigns menu. 

➢ Click  to close the menu in Mac. 

The new swirl is box selected. 

47. Cursor over the select box and click, drag and adjust the new object 
to enhance the base of the stem.  

TIP:  If you deselect accidentally, click the Group frame in the 
Filmstrip for the newly inserted gold Swirl 1. 

Alternately, click the first frame, and CTRL Shift and click the last 
frame in the gold color, if the SuperDesign inserted without a group. 

48. Right click over the highlighted (selected) frames in the Filmstrip and 
select Duplicate (Duplicate Selected). 

Use Duplicate when you want to copy and paste as slightly offset, all 
in one step. 

Use Copy and Paste when you want to place the new object directly over the top of 
the original. 
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49. Mirror  the now-selected duplicate with the handle  on the select box. 

50. Adjust the positioning as desired. 

TIP:  Zoom the view as needed.  Try out the slider in the Zoom toolbar, then drag the 
panning bars at right and/or bottom of the work area once you are zoomed more 
than the whole hoop view! 

 

Save the .edo as a Backup 

51. Make a back-up .edo file. 

• Click Save As  in the Quick Access bar, and name the file 
EditSuperDesignFlowers1Rose2, then follow the Save As dialogue box to browse 
to a folder and Save. 

➢ In Mac, click on the arrow at the end of the file name above the main toolbar, 
type in the new file name EditSuperDesignFlowers1Rose2, and then click the 
Where menu to browse to the folder where you want to save the backup. 

➢ Renaming in Mac does replace the original file with the new, and changes the 
file name, so it’s slightly different than Save As. 

All files saved from Digitizing are .edo files.  The .edo files can be reopened directly 
into Digitizing, or can also be inserted into the Embroidery module/application. 

Saving a backup file from Digitizing gives you the option to use just this SuperDesign 
later in another project! 

52. Close Digitizing to link back to Embroidery. 

• Click  in the upper right corner of Windows. 
➢ Click mySewnet™ Digitizing in the top menu and then select Quit mySewnet™ 

Digitizing so you are exiting the whole Digitizing program window in Mac. 

53. You are back in the Embroidery module/application, the linking flag is closed, and 
you are ready to use the QuiltBlock Wizard/Assistant to add the quilting to your 
design! 

Check out the design in the Filmstrip.   

Even though we had multiple objects in Digitizing, the design is one object in 
Embroidery because it was designed as a single Digitizing file. 

If you want to change your appliqué rose up more, just right click over the selected 
Filmstrip frame, or over the selected design in the work area, and choose Edit in 
Digitizing.
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Occasionally, you might end up with an extra frame in the 
Filmstrip that doesn’t have any stitches.  If so, simply select 
that frame, and then right click and select Delete.  

 

Add Quilting with Quilt Block Wizard 

54. Select the rose embroidery if necessary. 

55. Right click and select Cut to place it on the Clipboard block. 

56. Select the Create tab. 

➢ Click  in the Mac Control Panel. 

57. Select QuiltBlock . 

58. Select Filled Quilt Block; Inner Embroidery. 

59. Click Next or Continue. 

60. Select Shape 1, and enter the Size as a few mm smaller than the hoop (to give wiggle 
room). 

61. Uncheck Include a cut line. 

62. Click Next or Continue. 

63. Click Paste (Paste Embroidery). 

64. Click Next or Continue. 

65. In Adjust Embroidery, adjust the design as desired (pictured, 
Margin at 0). 

66. Click Next or Continue. 

67. Select Shape Fill .  

68. Click Options. 

69. Audition different shapes at different Density settings. 

Shown with Shape 13, Density 40. 

70. Or, try any of the other Fill Pattern styles! 

71. When you have made your perfect choice, click Finish or Done. 

72. In the Filmstrip, click Reveal Groups . 

73. Change the thread color for the quilting stitches. 

➢ Design tab  in Control Panel in Mac. 
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74. Review the design in Life View , then Cancel or Close. 

This design has an interesting echo of quilting stitches along the curls.  If you don’t 
like the look, you can open the Exported embroidery in Stitch Editor, and remove 
extra stitches there. Or, you can Fix as Embroidery, and then right click to Edit in 
Stitch Editor using linking. 

Or, use a 1mm or greater Margin in the Adjust Embroidery step! 

75. Use Save As to make a new working file named SuperDesignRoseWithQuilting.vp4. 

76. Then, Export or Send as desired so you can stitch a quilt block! 

 

Part 3:  A Technique for Designing Quilting to Custom Fit an 
Embroidery 

Are you interested in a specialty technique to design something in a little different 
style than the choices in the QuiltBlock Wizard/assistant?  Let’s design our own 
custom quilting stitches by linking to Digitizing from Embroidery!   

With a few extra steps, we can still keep the central design element separate from 
the quilting stitches, and keep both the quilting design and the embroidery design 
editable!    

1. Open a new mySewnet™ Embroidery window. 

2. Select Blank Canvas (Blank Project and Next in Mac). 

3. In Hoop Selection:  

• Hoop Group Universal,  

• Hoop Size 260mm x 260mm – Universal Square Hoop 5.   

• Orientation Natural. 
➢ Mac:  Brand Universal, Machine Group Universal, 260mm x 260mm – Universal 

Square Hoop 5.  Orientation Natural. 

4. Click OK. 

5. Select the SuperDesign tab. 

➢ Click  in the Mac Control Panel. 

6. Change Category to Food and Drink. 

7. Select the Menu Coffee Time 1, design 9 – Cappuccino.  

8. In Style, use Color. 

9. Change Size to 125mm (tab in Mac to refresh the field). 
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10. Click Apply. 

TIP:  If you forget to set the Size first, just right click after placing the Super Design, 
select Properties, and change to the desired size, a great benefit of Super Designs 
working element properties (green corner handles). 

If you prefer, you can select the Create tab ( in Mac) and link to Digitizing, then use 
Insert SuperDesign from there, make your edits as desired, and close Digitizing. 

11. Use Save or Save As to back up the embroidery where you can easily find it, naming 
it SuperDesign Cappucchino.vp4. 

12. Select the Create tab (  in Mac Control Panel). 

13. Click Digitizing  in the Insert menu. 

14. The Digitizing module/application opens. 

• Click Cancel in the Windows OS ExpressDesign Wizard. 
15. Select the QuickCreate tab. 

➢  in the Create Mode Menu , Main 
Toolbar. 

16. Click the lower half of the Fill menu to show all the specialty 
fill types, and change to QuiltStipple Fill . 

➢  Pattern and Line menu tools in Mac 
secondary toolbar. 

Or, select any of the other specialty fill types as desired. 

17. Click the lower half of the Line menu and select No Border Line for the border line. 

When No Line is selected, the icon becomes deselected (unhighlighted) to indicate 
the border is off, no matter what border style is visible in the menu’s preview. 

18. Click the arrow on the Shape menu preview  and select Shape 3. 

Windows menu   Mac Menu   

19. Click Shape to place a square of quilt stippling into the work 
area. 
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20. If the design is a little off center use the keyboard arrow keys to nudge the selected 
design until the Flip Vertical and Flip Horizontal handles are centered on the bolder 
horizontal and vertical center grid markers.  

21. Make sure the QuiltStipple object is Box Selected  (Quick Select toolbar in 
Windows in all tabs; Select tools in Main Toolbar in Mac). 

22. Hold down the Control Shift keys in Windows or the Option Shift keys in Mac, and 
drag the select box larger so the stippling will fill the hoop. 

TIP:  If you aren’t sure if the design still fits within the hoop, click Life View .  If 
Life View opens, the embroidery is within the hoop.  If it’s too large for the hoop, you 
will get an error message. 

 

Cut a Hole in the Fill 

We are going to insert our saved SuperDesign Cappuccino and use it as a template to 
cut a hole in the fill, then delete the Cappuccino before we close the link to go back 
into the Embroidery module/application.  Using this technique, we will end up with a 
separate stippling design that exactly matches the SuperDesign Cappuccino we 
created! 

23. Click the Home tab in Windows Digitizing, and click Insert Embroidery. 

➢ Click the Edit menu, cursor over Insert, and select Insert Embroidery in Mac. 

24. Browse to and select SuperDesign Cappuccino that you saved. 

25. Click Open. 

The saved embroidery design places at the same relative location as it was saved.  

Do not move or change the inserted embroidery design or it will not match up with 
the original design placement when we close the link to Digitizing! 

26. Scroll the Filmstrip and find the QuiltStipple Fill, then click the Filmstrip Frame to 
select it. 

The Fill area has to be the selected object before you can make a hole in it. 

27. Select the Point Create tab (so you can place points yourself for accuracy). 

➢ Point Create  in the Create Mode toolbar , main toolbar in Mac. 

28. Click Hole  in the main menu toolbar. 
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29. Click to place points around the inserted embroidery design, keeping the points 
sequential (like beads on a string, so you don’t ‘twist’ the hole border and make a 
twist in the hole).   

After you click 3 points, you’ll see a loop form, and as you continue to click additional 
points, the loop will enlarge accordingly. 

• Hold down the Shift key to make a square point. 

• Click a point to make a round point (for curving shaping). 

• Cursor over an already placed point to click and drag it into a new position, but 
keep the points sequential on the line. 

• Cursor over a square point and click it to make it round. 

• Cursor over a round point and click to make it square. 

 
30. When finished, right click to finish making the Hole. 

• The tool is still active, so you could add another hole. 

• Right click a second time to release the Hole tool. 
➢ In Mac, right click and select Finish Drawing the line if you want to make 

another hole, or Finish Point Hole to release the tool. 

31. In the Filmstrip, select the Group frame created when you inserted the saved 
Cappuccino embroidery. 

When you select the Group frame, you select all the objects in the group. 
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32. Right click over the selected frame and select Delete (Delete Object) to remove the 
Cappuccino. 

We used the saved version as a template, so we need to remove it.  If we closed the 
link, we would have two Cappuccinos, and one would be part of the quilt stipple, 
requiring the use of the Modify tab or of Stitch Editor to remove.   

We still have the original in the linked Embroidery module/application! 

33. Close Digitizing. 

• Click  in the upper right corner of Windows. 
➢ Click mySewnet™ Digitizing in the top menu and then select Quit mySewnet™ 

Digitizing so you are exiting the whole Digitizing program window in Mac. 

The new stippling design has its own frame in the Embroidery module/application 
filmstrip. 

34. Use Control A (Command A in Mac) to select both embroideries. 

35. Select the Home tab in Windows (Design tab  in Mac) and then click Center in 

the Hoop . 

36. Examine the QuiltStipple Fill in the Filmstrip. 

• The identifying symbol shows it is a Design Object (Digitizing 

.edo file) , which is fully size-adjustable in the 
Embroidery window, or can be opened and edited in 
Digitizing. 

37. Examine the SuperDesign cappuccino. 

• The identifying file type symbol shows it is a SuperDesign 

 that hasn’t been Fixed (closed), which is also fully 
editable and size-adjustable.  

38. Click the Filmstrip frame for the Cappuccino SuperDesign. 

39. Right click and select Satin Column from the pop up menu. 

The Satin Column has no Pattern Fill to break up the stitches (Pattern 0), and might 
snag at this large a size. 

40. Open the Pattern gallery view  (three dots button in Mac ). 

41. Select any pattern you’d like to audition, then click OK to close the Satin Column 
properties dialogue box. 
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42. View more closely with Life View , then Cancel or Close. 

 
43. Save As SuperDesignCappuccinoWithQuilting, and then Export or Send to mySewnet 

functions. 

 

Take some time to go back through all the other block types in the QuiltBlock Wizard, 
as well!  There are options that make a great quilting design for plain blocks, or as 
Trapunto-style, or simply stitch around the perimeter of a block to secure the batting. 

Take a little time to get to know the tools, and enjoy quilting your next pieced 
creation! 


